TurboTax Facts

Section 1 – FAQs
Section 2 – Important Terms & Conditions
Section 3 – TurboTax Instructions
Section 4 – TurboTax Download for your Tax Professional
TurboTax® Frequently Asked Questions

Should you have any questions or run into any difficulties, you may find your answers in one of the FAQ’s below. Additional technical questions should be directed to Intuit®, the company that supports TurboTax®.

Please also visit our TurboTax® Import Instructions for an overview of how to import your BB&T Securities tax information into TurboTax®.

1. What are TurboTax® products?
TurboTax® software is a product from Intuit, a third-party vendor. TurboTax® products help you prepare and file your federal and state tax returns. With TurboTax® products, you can import your BB&T Securities tax-related data into your TurboTax® returns.

Although BB&T Securities is providing the tax information import as an additional service, BB&T Securities does not guarantee that the information provided is sufficient for tax reporting purposes, and BB&T Securities is not liable for your reliance upon or use of the import feature or the data provided through such feature. If you have specific questions regarding the preparation of your tax return, contact your tax advisor or the IRS.

2. What if I don’t have TurboTax®?
You can purchase TurboTax® software and online products at the TurboTax® Web site. You can also find TurboTax® software products in computer and general retail stores. Please visit the TurboTax® Web site for more information.

3. Can I import my BB&T Securities Tax Statement or 1099-R into TurboTax® products for Mac?
Yes. TurboTax® is available for both Mac and PC platforms and both platforms are supported by BB&T Securities, LLC.

4. Who can import their BB&T Securities tax-related data into their TurboTax® returns?
Any client receiving a 1099 Tax Statement or a REMIC/WHMT Tax Statement can import their data into TurboTax. Accounts receiving Form 1099-R will also be able to import their data into TurboTax.

5. Will I still receive my BB&T Securities tax documents in the mail?
Yes. You will continue to receive your BB&T Securities tax forms in the mail. The BB&T Securities tax forms are the official documents sent to the IRS and the TurboTax® service is not a substitute for your printed BB&T Securities tax forms. This import feature provides you with the opportunity to import your BB&T Securities tax-related data into your TurboTax® return, thereby reducing manual entry of data, but should not be considered an official record. Please review the imported data against the printed BB&T Securities tax forms.

6. How much does the TurboTax® import service cost?
Importing BB&T Securities tax-related data into your TurboTax® return is free to all BB&T Securities clients. Please note that traditional Internet usage fees may apply.

7. Do I need to be on BB&T Securities, LLC’s Web site to import the information?
No. The TurboTax® program provides an import feature that will import the relevant tax information. Please see our TurboTax® Import Instructions for more information.

8. Which IRS 1099 tax forms can I import from BB&T Securities, LLC?
BB&T Securities provides information from IRS Forms 1099-B (Proceeds from Broker and Barter Exchange Transactions), 1099-DIV (Dividends and Distributions), 1099-INT (Interest Income), 1099-MISC (Miscellaneous Income), 1099-OID (Original Issue Discount), 1099-OID REMIC (Real Estate Mortgage Investment Conduit), 1099-INT WHMT (Widely Held Mortgage Trust) and 1099-R (Distributions from Pensions, Annuities, Retirement or Profit-Sharing Plans, IRAs, Insurance Contracts, etc.) available for import into your TurboTax® return.

9. If I am a beneficiary of a decedent IRA, will I be able to import IRS Form 1099-R from BB&T Securities, LLC?
No. BB&T Securities does not support the import of IRS Form 1099-R for beneficiaries (Distributions from Pensions, Annuities, Retirement or Profit-Sharing Plans, IRAs, Insurance Contracts, etc.).

10. Can I import IRS Form 1099-Q from BB&T Securities, LLC?
No. BB&T Securities does not support the import of IRS Form 1099-Q (Payments from Qualified Education Programs under Sections 529 and 530).

11. Will TurboTax® products interact with BB&T Securities, LLC’s Quicken® download service?
No. The Quicken® download service BB&T Securities offers is primarily for tracking transactions and holdings. BB&T Securities does not recommend or support the effort of using the Quicken® downloaded data for income tax purposes. Your printed BB&T Securities tax document is the official record used as a basis for importing into your TurboTax® return.
12. When will TurboTax® import data be available for download?
For IRA accounts receiving a Form 1099-R, TurboTax® import data will be available in late January. TurboTax® import data for accounts receiving a BB&T Securities Tax Statement (Consolidated 1099) will be available for download at the same time which you receive the hardcopy of your Consolidated 1099 in the mail.

13. When will REMIC/WHMT data be available for download?
The IRS deadline to issue the REMIC/WHMT Tax Statement is March 15. Data will be available for import into the TurboTax® return when you receive the hardcopy of your document in the mail. Be sure to verify the TurboTax® import against the printed BB&T Securities REMIC/WHMT Tax Statement and the printed BB&T Securities Tax Statement (Consolidated 1099).

14. What should I do if the original BB&T Securities Tax Statement (Consolidated 1099) I receive indicates that I own a REMIC or WHMT?
You should wait until the REMIC/WHMT data is available and then import all of your Tax Statement data at once. See question, "When will REMIC/WHMT data be available for download?"

15. Who should I contact if I have trouble importing the data?
For technical questions about TurboTax® product installation, usage and functionality, please visit turbotax.intuit.com/support. If you are having difficulty with the import process, please review TurboTax® support tab for assistance. Since the TurboTax® program is a third-party application there are limitations to what support BB&T Securities can offer in the import process.

16. What if I do not see BB&T Securities as a Financial Partner to import tax information from within the TurboTax® program?
If you do not see BB&T Securities in the list of available Financial Partners, you will need to process the TurboTax® program update. Within TurboTax®, go to the menu option: Online > Check For Updates and follow the on-screen prompts. When the update completes, please attempt the import again. Please visit the TurboTax® Import Instructions for more information on how to initiate the import process or visit TurboTax® Support for more details.

17. What information do I need to log in to use the TurboTax® import?
To import your BB&T Securities Tax Statement (Consolidated 1099) into TurboTax® you will need your Account Number and Document ID. Please see “Where do I find my Document ID?” for help locating your Document ID number.

18. Where do I find my Document ID?
Your Document ID can be found in the upper right-hand corner of the BB&T Securities Tax Statement (Consolidated 1099). Your BB&T Securities Tax Statement will be mailed to you and will also be available electronically for those clients signed up for tax eDocuments.

19. What information from my BB&T Securities Tax Statement (Consolidated 1099) will not import into the TurboTax® return?
The "Non Reported Income, Fees, Expenses and Expenditures" (includes margin interest charged, master limited partnership distributions, etc.) section of the BB&T Securities Tax Statement will not import into TurboTax® returns. This information must be manually entered into the TurboTax® program.

Cost basis on certain Form 1099-B transactions will not import into TurboTax® returns (Please see questions 21–28 for additional information).

Form 1099-B "Regulated Futures Contracts” (Section 1256 Contracts) Boxes 10, 11, 12, 13 is not supported by the TurboTax® import. This information must be manually entered into the TurboTax® program.

20. Will Master Limited Partnership distributions import into TurboTax®?
No. The tax information imported into TurboTax® does not include distributions paid to your brokerage account for Master Limited Partnerships. In addition, you should refer to your own tax records to accurately record the cost basis information to supplement any sale information, which will be imported into TurboTax®. You should receive a separate Schedule K-1, issued directly by the partnership. General partners normally do not issue K-1s until after March 15th.

21. Will Cost Basis information from Form 1099-B import into TurboTax®?
Yes. Cost basis from Form 1099-B will import into TurboTax® for both covered and noncovered securities.

22. What is the difference between a covered security and a noncovered security on Form 1099-B?
Covered securities are those that are acquired on or after the applicable dates outlined by IRS Cost Basis Legislation. Both the gross proceeds and adjusted cost basis amounts for covered securities provided on Form1099-B will be reported by BB&T Securities to the IRS. For sales of covered securities, your tax return must include all gross proceeds and adjusted cost basis amounts BB&T
Securities reports on Form 1099-B, as the IRS will compare your tax return to what is reported by BB&T Securities, LLC. You should reconcile any differences with your own tax records and provide supporting documentation accordingly.

Noncovered securities are those that are acquired before the applicable dates outlined by IRS Cost Basis Legislation. Only the gross proceeds for noncovered securities provided on Form 1099-B will be reported by BB&T Securities to the IRS. The cost basis will not be reported to the IRS but is provided to you for informational purposes only. For sales of noncovered securities, your tax return must include all gross proceeds amounts BB&T Securities reports on Form 1099-B, as the IRS will compare your tax return to what is reported by BB&T Securities, LLC. The cost basis provided on Form 1099-B for noncovered securities may require adjustment and should be validated against your own tax records.

23. What determines if a security is considered covered on Form 1099-B?
Beginning with securities purchased on or after January 1, 2011, BB&T Securities is required to report both adjusted cost basis and gross proceeds of any covered security to the IRS. A security is considered covered based on the year of purchase:

Equities: January 1, 2011

Mutual funds and dividend reinvestment plans (DRIPs): January 1, 2012

Other securities including fixed income and options: January 1, 2014

Complex debt securities: January 1, 2016

Current Cost Basis Legislation excludes some securities from becoming covered (e.g. Royalty Trusts, HOLDRs, UIT Grantor Trusts, and Widely Held Mortgage Trusts). The cost basis for these types of securities and those that are not yet effective (noncovered) will not be reported to the IRS. All gross proceeds amounts will be reported to the IRS regardless if the securities are considered covered or noncovered.

24. Will cost basis for noncovered securities be provided on Form 1099-B and included in the TurboTax® import process?
If known to BB&T Securities, LLC, the cost basis and acquisition date of noncovered securities will be supplied on the BB&T Securities Tax Statement (Consolidated 1099) and in the TurboTax® import. However, this information may be missing, may not reflect all of the necessary adjustments or may need adjustment if you have used other methods for tracking and/or reporting the cost basis for particular securities. You should verify the cost basis information supplied on your BB&T Securities Tax Statement (Consolidated 1099) and in the TurboTax® import against your own tax records. The TurboTax® software will allow you to adjust any of the cost basis information imported.

25. What accounting method does BB&T Securities use to liquidate tax lots?
BB&T Securities liquidates tax lots based on your default accounting method (usually FIFO) unless you have instructed us otherwise. Due to IRS regulations, tax lots cannot be changed after the settlement date of the sale trade.

26. Will Wash Sale information from Form 1099-B import into TurboTax®?
Yes, but only for certain transactions identified on Form 1099-B as Wash Sales.

It is important to note that the Cost Basis Legislation requires BB&T Securities to track wash sales that occur in the same account (although not across different accounts for the same client) with securities that have the same CUSIP. This is different than the formal definition of a wash sale, which includes any “substantially identical” securities, including those which may have different CUSIP numbers. Note: Although the IRS has provided simplified assumptions for brokerage firms to report wash sales, as a client you must continue to keep track of wash sales if they occur across multiple accounts or in “substantially identical” securities.

27. Where can I find more information regarding the IRS Cost Basis Legislation?
Please see What Investors Should Know about the New Cost Basis Reporting Requirements for more information on how Cost Basis Legislation impacts the reporting of certain transactions to the IRS.

28. Will Original Issue Discount tax information import into TurboTax®?
Yes. However, Original Issue Discount (OID) reported on IRS Form 1099-0ID and imported into your TurboTax® return is calculated assuming the bonds were purchased on the Date of Original Issue and at the Original Issue Price. If you purchased the bonds at a market premium or market discount, or if the obligation is either a stripped bond or coupon, you must compute your proper amount of OID. The import feature of TurboTax® does not calculate any OID adjustments to reflect your purchase date or purchase price. Cost basis related to these types of transactions is not supported in the TurboTax® download. Refer to your own tax records to accurately record the cost basis information to supplement the sale information, which will be imported into TurboTax®.
29. Will option transactions be imported into TurboTax®?
Yes. The tax information import does support the import of certain Closed Options Transactions (calls/puts) and the related cost basis information. While these transactions are not reported to the IRS, Options transactions must be reported on your IRS Form 8949 and Schedule D. All Option transactions must be reviewed with your tax records. Consult your tax advisor for additional information.

31. What happens if the TurboTax® information is different than the information on tax forms I receive in the mail?
The printed BB&T Securities tax document is the official source of information. The information you import should be verified against the mailed copy.

If there are major discrepancies between the BB&T Securities tax documents and the TurboTax® import data, you may report them to your Financial Advisor or Investment Counselor. Since TurboTax is a third application, there are limitations to what support BB&T Securities can offer in the import process.

32. Why do the amounts on my BB&T Securities Tax Statement (Consolidated 1099) differ from my BB&T Securities December Client Statement?
The reclassification of distributions between the end of December (when the December statement is issued) and mid-February or March (when the BB&T Securities Tax Statement is issued) often leads to the difference in figures. Additionally, mutual fund companies sometimes make a distribution, which is reportable in one year, but not actually paid until the following year. In cases where the December Client Statement and the BB&T Securities Tax Statement (Consolidated 1099) do not match, you should use the information contained on the BB&T Securities Tax Statement (Consolidated 1099) when preparing your tax return.

33. What happens if I receive a “corrected” BB&T Securities Tax Statement (Consolidated 1099) or Form 1090-R in the mail?
You can manually adjust your TurboTax® return to reflect the “corrected” BB&T Securities Tax Statement/1099-R information. When referring to your BB&T Securities Tax Statement for “corrected” information, a “C” will appear next to any item that has been changed. You may also re-import the TurboTax® data into your return, to do so: Click the File menu, select Remove Imported Data, select the appropriate account number and click Remove All. Finally, re-import the corrected tax information. Please see our TurboTax® Import Instructions for more information on how to import your BB&T Securities tax-related data.

34. Can I use the import for my State Tax Return?
The tax information import is based on reporting requirements for your federal tax return. It is not meant to support state tax returns. If you are using this information to complete your state tax return through TurboTax® or otherwise, obtain your state income tax reporting regulations to determine any adjustments or modification to the information provided. For example, tax-exempt municipal income and income derived from certain U.S. Treasury obligations may not be properly imported for the completion of your state income tax return.

35. What type of security do you employ?
Any time you use the TurboTax® import process and provide personal information (such as an account number or password), it is encrypted using 128-bit Secure Socket Layer (SSL) technology. SSL protects information as it crosses the Internet. To support this technology, you need an SSL-capable browser. The browser will activate SSL automatically whenever you use the TurboTax® download. Microsoft’s Internet Explorer 6.0 or higher is required to run TurboTax® software; a version of Internet Explorer is provided on the TurboTax® software CD.

36. Do TurboTax® products have my account information?
No. The TurboTax® products do not have your BB&T Securities account information. Your TurboTax® import request retrieves the relevant tax information from an industry standard Open Financial Exchange (OFX) server over a secured Internet connection. All of your account information for the TurboTax® import is located and stored at BB&T Securities or an authorized third party. All such information is maintained in accordance with BB&T Securities, LLC’s privacy policy.

37. What is OFX?
Open Financial Exchange (OFX) is a unified specification for the exchange of electronic financial data over the Internet. The OFX specification streamlines the process financial services companies must go through to connect to transactional Web sites, personal computers and personal financial management software. Further information about OFX can be found at www.ofx.net.

TurboTax and TurboTax Online, among others, are registered trademarks and/or service marks of Intuit Inc. in the United States and other countries. Intuit Inc. is not affiliated with BB&T Securities, LLC and is solely responsible for the information provided by Intuit Inc. for users of TurboTax software. BB&T Securities, LLC cannot guarantee that Intuit Inc. supplied information and content are accurate, complete, or timely and does not make any warranties, conditions, guarantees, or representations regarding the results obtained from such use.
Tax Import Terms and Conditions

BB&T Securities Tax Information Import Terms and Conditions

BB&T Securities does not provide tax advice. It is important that you consult a professional tax advisor regarding your individual tax situation.

BB&T Securities shall provide you the ability to electronically access certain tax-related information contained in your BB&T Securities tax documents via TurboTax® through your computer or other electronic device (the “Service”). BB&T Securities may cancel or change its provision of the Service at any time upon printed or posting of electronic notice to you. Your continued use of the Service following the posting or notice of any changes will constitute your acceptance of such changes. You agree not to attempt to access the Service if you do not agree to the terms of this Agreement.

In the event you use BB&T Securities OnLine (the “Site”) or the links included on the Site to gain access to an Internet location or electronic source of information of any company, organization or person other than BB&T Securities, LLC, you acknowledge that such other Internet Web sites or locations are not under the control of BB&T Securities and you agree that BB&T Securities shall not be responsible for any information or other links found at any such Web site or location or for your use of such information. BB&T Securities provides such links only as a convenience to you.

Carefully Review All Information You Import Against the Printed BB&T Securities Tax Documents

Be sure to verify the information that you import into TurboTax® against the printed BB&T Securities tax documents. Not all information from the printed BB&T Securities tax documents is supported by the TurboTax® import feature. Some information from the BB&T Securities tax documents must be manually entered into the TurboTax® program including but not limited to items from the "Non Reported Income, Fees, Expenses and Expenditures" section of the BB&T Securities Tax Statement (e.g., accrued interest paid on purchase, margin interest charged, master limited partnership distributions, etc.).

Unless we otherwise notify you in writing, any information provided through the Service shall not be deemed to supersede or replace your BB&T Securities tax documents or any "Corrected" BB&T Securities tax documents. The printed BB&T Securities tax documents are the official forms which BB&T Securities files electronically with the IRS. Per IRS regulations, if you are required to file a return, a negligence penalty or other sanction may be imposed on you if the income from the BB&T Securities tax documents is taxable and the IRS determines that it has not been reported. Remember, taxpayers are ultimately responsible for the accuracy of their tax returns.

BB&T Securities Does Not Provide Tax Advice

Although BB&T Securities is providing the tax information import as an additional service, BB&T Securities does not guarantee that the information provided is sufficient for tax reporting purposes, and BB&T Securities is not liable for your reliance upon or use of the import feature or the data provided through such feature. It is essential that you complete the TurboTax® Interview and/or Review processes in their entireties to ensure that you properly complete the investment income portion of your tax returns as the imported data may not accurately reflect all information needed for tax reporting.

Be sure to compare the data you import into TurboTax® against the printed BB&T Securities tax documents to ensure accurate and complete reporting of all required tax information on your federal and/or state tax return(s). You may be required to add, modify, delete or otherwise act upon some or all of the information that you import. Certain information may be imported; however, you may be required to make an affirmative choice as to how it should be accounted for on your federal tax return.

If you have specific questions regarding the preparation of your tax return, contact your tax advisor, the IRS or the state(s) to which you report.
About the Import Data
Your imported tax data is based on information known to BB&T Securities, LLC. The data is periodically updated to reflect adjustments as indicated on any subsequent “Corrected” BB&T Securities tax documents. BB&T Securities supports the import of data from IRS Forms 1099-DIV, 1099-INT, 1099-OID, 1099-MISC, 1099-B, 1099-OID REMIC, 1099-INT WHMT and 1099-R. The imported data may not include all adjustments or information necessary in the preparation of your tax return. BB&T Securities provides the following information sources to help you complete your tax return. We recommend that you read the following information:

BB&T Securities TurboTax® Frequently Asked Questions and Import Instructions.


The import data containing your tax information is subject to amendment and, if applicable, BB&T Securities will issue you “Corrected” BB&T Securities tax documents.

TurboTax® and TurboTax® Online, among others, are registered trademarks and/or service marks of Intuit Inc. in the United States and other countries. Intuit Inc. is not affiliated with BB&T Securities, LLC, and is solely responsible for the information provided by Intuit Inc. for users of TurboTax® software. BB&T Securities cannot guarantee that Intuit Inc. supplied information and content are accurate, complete, or timely and does not make any warranties, conditions, guarantees, or representations regarding the results obtained from such use.

It is important to understand that the tax information imported into TurboTax® products may not be all of the information required for you to properly complete the investment income portion of your federal and/or state tax return. It is essential that you complete the TurboTax® Interview and/or Review processes in their entireties to ensure that all imported information is correctly reported to the IRS and/or the state(s) to which you report.

Be sure to verify the information that you import with your own records in order to ensure accurate and complete reporting of all required tax information on your federal and/or state tax return(s). Although BB&T Securities is providing the tax information import as an additional service, BB&T Securities does not guarantee that the information provided is sufficient for tax reporting purposes, and BB&T Securities is not liable for your reliance upon or use of the import feature or the data provided through such feature. If you have specific questions regarding the preparation of your tax return, contact your tax advisor, the IRS, or the state(s) to which you report.

The printed BB&T Securities 1099 tax forms are the official record of 1099 information maintained at BB&T Securities, LLC. BB&T Securities disclaims any liability arising from the use of TurboTax® software or the content furnished by Intuit Inc., including but not limited to, any resulting information obtained from such use, or interpretations of information made as a result of such use.
You may import your BB&T Securities Tax Statement (1099-DIV, INT, MISC, OID, B, REMIC/WHMT Tax Statement) or Form 1099-R (for Retirement Accounts) from your account into TurboTax®.

The instructions below will provide you the steps to assist you with importing your BB&T Securities tax-related data. BB&T Securities does not support the TurboTax® software; you may direct your questions to Intuit®, the company that supports TurboTax®.

**Terms and Conditions**
By using the TurboTax® Import process, you are agreeing to the BB&T Securities [Tax Import Terms and Conditions](#).

**Frequently Asked Questions**
Should you have any questions or run into any difficulties, you may find your answers on the [FAQ’s page](#). Additional technical questions should be directed to Intuit®, the company that supports TurboTax®.

**Importing BB&T Securities Tax-Related Data Into Your TurboTax® Return:**

1. If you have not already started your TurboTax® return, from the File menu in TurboTax®, select **New Tax Return**.
2. From the File menu select **Import**, then select **From Financial Institution**.
3. In the box labeled **I'm looking for:** type BB&T Securities, LLC
   a. **Importing your BB&T Securities Tax Statement (1099-DIV, INT, MISC, OID, B), and REMIC/WHMT Tax Statement:**
      - Select BB&T Securities, LLC (1099 Tax Statement) from the scrolling list box and click **Continue**.
      - From the Sign on to BB&T Securities (1099 Tax Statement) screen, enter your BB&T Securities eight-digit account number (no dashes), and your Document ID (including dashes); then click **Continue** (a dialog box will appear to let you monitor the status of the download process).
      - Proceed to Step 7 below to continue importing your tax information into your TurboTax® return.
   b. **Importing your 1099-R:**
      - Select BB&T Securities, LLC (Form 1099-R) from the scrolling list box and click **Continue**.
      - From the Sign on to BB&T Securities (Form 1099-R) screen, enter your BB&T Securities eight-digit account number (no dashes), BB&T Securities User ID and password; then click **Continue** (a dialog box will appear to let you monitor the status of the download process).
      - Proceed to Step 4 below to continue importing your tax information into your TurboTax® return.
4. Your tax forms will appear on the **These Documents Are Now Ready for Import** screen. To view the details of each document, click **View Details** to the right of the document. A dialog box will appear detailing the items TurboTax® will import; when you are finished reviewing the details, select **Close** to return to the **These Documents Are Now Ready for Import** screen.
5. Click **Import Now** to import the selected items into your TurboTax® return (a dialog box will appear to let you monitor the status of the download).
6. Click **Import Now** to import the selected items into your TurboTax® return (a dialog box will appear to let you monitor the status of the download).
7. From the **Import Summary** screen, select **Done**.
8. Click **Continue** to begin the TurboTax® interview process.

If you have multiple accounts with BB&T Securities, LLC, please repeat the above steps for each account to import the relevant tax information for each account into your TurboTax® return.

**Helpful Hint:**
To review the data imported into your TurboTax® return at any time, go to the Tools menu in the TurboTax® program and select My Tax Data (a dialog box will appear to show the details. Items with Import listed in the Source column are items that were imported from BB&T Securities or another financial institution); select **Cancel** when you are finished reviewing the information.

BB&T Securities can only assist you with the technical download. If you have any trouble after downloading, you will need to contact TurboTax® for assistance. TurboTax® is a registered trademark of Intuit Inc. and is used with permission.
TurboTax® and TurboTax® Online, among others, are registered trademarks and/or service marks of Intuit Inc. in the United States and other countries. Intuit Inc. is not affiliated with BB&T Securities and is solely responsible for the information provided by Intuit Inc. for users of TurboTax® software. BB&T Securities cannot guarantee that Intuit Inc. supplied information and content are accurate, complete, or timely and does not make any warranties, conditions, guarantees, or representations regarding the results obtained from such use.

It is important to understand that the tax information imported into TurboTax® products may not be all of the information required for you to properly complete the investment income portion of your federal and/or state tax return. It is essential that you complete the TurboTax® Interview and/or Review processes in their entireties to ensure that all imported information is correctly reported to the IRS and/or the state(s) to which you report.

Be sure to verify the information that you import with your own records in order to ensure accurate and complete reporting of all required tax information on your federal and/or state tax return(s). Although BB&T Securities is providing the tax information import as an additional service, BB&T Securities does not guarantee that the information provided is sufficient for tax reporting purposes, and BB&T Securities is not liable for your reliance upon or use of the import feature or the data provided through such feature. If you have specific questions regarding the preparation of your tax return, contact your tax advisor, the IRS, or the state(s) to which you report.

The printed BB&T Securities 1099 tax forms are the official record of 1099 information maintained at BB&T Securities, LLC. BB&T Securities disclaims any liability arising from the use of TurboTax® software or the content furnished by Intuit Inc., including but not limited to, any resulting information obtained from such use, or interpretations of information made as a result of such use.

**Return to top**
NEW FOR TAX YEAR 2014

TurboTax Download for your Tax Professional

Intuit, the makers of TurboTax, has recently announced that the tax data import features that let customers electronically download tax forms from their financial institutions into TurboTax are coming to Intuit professional tax preparation solutions for accountants. The suite of solutions that have this integration include Intuit Lacerte, Intuit ProSeries, and Intuit Tax Online.

These professional tax solutions will let taxpayers import IRS 1099 tax documents supported by the OFX standard and share those documents with their accountants. Those forms include the 1099-INT, 1099-DIV, 1099-B, 1099-R, 1099-MISC and 1099-OID. Additional tax forms such as W-2’s and 1098’s will be supported in the future.

The introduction of these features to Intuit professional tax solutions means you will be able to take advantage of this easy, web-based tax data import whether you do your own taxes with TurboTax or work with a tax accountant who uses the latest Intuit offerings for tax pros.

FAQs about Intuit’s new professional tax solutions and 3rd party tax form import

Q: What Intuit professional tax solutions will be using this new integration?
A: The solutions that will take advantage of the added 3rd party import capabilities include two related offerings that are both geared to help accountants more easily collect important documents and data from their clients. They include Intuit Tax Form Dropoff and a new offering called Intuit Link. If your accountant uses Intuit’s professional tax prep solutions, they may invite you to use one of these tools.

Q: Will CPAs be able to import my tax form data directly?
A: No. Accountants must request any forms or documents they need from you via the customer interfaces in Intuit Link or Intuit Tax Form Dropoff. You will need to log in and download your BB&T Securities tax information, which can then be shared with your CPA.

Q: How do I download my tax information?
A: Your tax preparer will send you an email inviting you to Intuit Link or Intuit Tax Form Dropoff and then you will be prompted to sign in or register for an Intuit ID.

1. Once you login, there will be an option to search for your financial institution that provides the 1099 forms. Search for and select BB&T Securities, LLC from the search results.
2. From the Sign on to BB&T Securities screen, enter your BB&T Securities eight-digit account number (no dashes), and your Document ID (including dashes).
3. Intuit Link or Tax Form Dropoff will download your tax documents, and they will be automatically shared with your tax preparer through Intuit Link or Tax Form Dropoff.

Return to top